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HR metrics and organizational people-related data are an invaluable source of information

from which to identify trends and patterns in order to make effective business decisions. But

HR practitioners often lack the statistical and analytical know-how to fully harness the potential

of this data. Predictive HR Analytics provides a clear, accessible framework for understanding

and working with people analytics and advanced statistical techniques. Using the statistical

package SPSS (with R syntax included), it takes readers step by step through worked

examples, showing them how to carry out and interpret analyses of HR data in areas such as

employee engagement, performance and turnover. Readers are shown how to use the results

to enable them to develop effective evidence-based HR strategies.This second edition has

been updated to include the latest material on machine learning, biased algorithms, data

protection and GDPR considerations, a new example using survival analyses, and up-to-the-

minute screenshots and examples with SPSS version 25. It is supported by a new appendix

showing main R coding, and online resources consisting of SPSS and Excel data sets and R

syntax with worked case study examples.



PRAISE FOR PREDICTIVE HR ANALYTICS, SECOND EDITION‘Predictive HR Analytics is a

comprehensive and detailed guide for any professional interested in this exciting new field. It

will help you understand what data to analyse, how to interpret and analyse it, and how

different types of models work. Highly recommended for people analytics specialists.’Josh

Bersin, global industry analyst and Founder of Bersin by Deloitte‘Edwards and Edwards

provide an essential road map to professionalize how HR analytics is applied in organizations.

This book should be required reading for data scientists and HR generalists who need to learn

the ropes of applying statistics and social scientific analysis to HR data.’Alec Levenson, Senior

Research Scientist, Center for Effective Organizations, University of Southern California, and

author of Strategic Analytics and Employee Surveys That Work‘An essential read for HR

leaders and practitioners wishing to deepen their knowledge and capability in predictive

analytics. The authors balance the need to present technical concepts and theory with clear

and simple solutions to apply within the workplace. This book is full of wisdom for anyone

wishing to embrace analytics as a fundamental HR capability.’Caroline van der Feltz, HR

Director, Danske Bank UK‘Finally – a book that students and HR professionals can use to

learn how to do HR analytics! Not only do Edwards and Edwards show how to conduct

analyses with clear, step-by-step examples, they show the critical insights that HR analytics

can provide.’Fritz Drasgow, Dean, School of Labor and Employment Relations, and Professor

of Psychology, University of Illinois at Urbana-Champaign‘Predictive HR Analytics is a practical

guide for anyone working or interested in the burgeoning field of people analytics. What sets it

apart from other books on the topic is that the authors demonstrate how to actually perform the

analyses with a variety of HR-related data, as well as providing insights on the statistical

models that support them. Every people analytics team should own a copy of this book.’David

Green, Executive Director, Insight222, and global speaker, writer and consultant on people

analytics‘Detailed, precise and clearly written, this book isn’t just about statistics, it’s about the

future of HR. Essential reading for everyone in HR.’Professor Binna Kandola OBE, Business

Psychologist, Senior Partner and Co-founder, Pearn Kandola‘Anyone reading and learning

from this book and applying its lessons will be a more effective HR professional. It should

certainly become compulsory reading for all HRM students. The authors are to be

congratulated on providing a service to the HR community by writing this much-needed and

timely book.’David Guest, Professor of Organizational Psychology and Human Resource

Management, King’s College London‘At a time when the HR function is facing huge changes

and undergoing massive challenges, it is good to see the second edition of this noteworthy

book. Whilst many in HR are still coping with reporting on metrics, Edwards and Edwards have

updated and expanded their first edition by embracing the latest developments and staying

ahead of the curve. This will make a welcome contribution to the knowledge base of academics

and practitioners alike.’David Simmonds, Chairman, HR Analytics LtdSecond EditionPredictive
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is forThis book is for anyone working in the human resource (HR) function, anyone working in a

management information (MI) function, anyone who is studying HR, management or business

analytics, and anyone who has to make decisions about people in an organizational

context.DIYThe key difference that this book has over other books on predictive HR analytics is

that we show you how to actually run analyses with different types of HR-related data and we

also guide you through the statistical models required for each type of analysis. Furthermore,

we also show you how to run the analysis with SPSS. Whilst there are books on the market

that discuss HR analytics, and there are also books out there that show people how to run

statistical analysis with SPSS, few books combine both of these. In addition to this, in this

second edition we include an appendix (R) that outlines some R syntax examples to run the

statistical tests in our book. We have also made available a PDF document and R syntax

download folder on the Kogan Page website () that demonstrates how to run the analyses in R

that the book presents in SPSS. This book could be used by anyone who wants to learn

statistical analysis techniques, and we use applied HR data here. It is not designed to be just a

statistics book, but we go through the statistical procedures in enough depth for the reader not

to need to buy a stats book as well (until they get a bit more advanced). However, this book is

likely to be the most useful for people who want to get some experience running statistical

models with HR data. This could be students on an HR master’s degree or it could be MI

practitioners who want some guidance on how to apply statistical models to their HR data.How

to use this bookThe structure of this book includes a brief introduction in Chapter 1 to the field

of predictive HR analytics, where we set out how and why the analytic methods used in this

book are different from the kind of activity that HR functions and MI teams currently undertake

as a norm.In Chapter 2 we discuss the nature of HR data and demonstrate how to convert HR

data into a workable form to analyse with SPSS. We also explain why we use SPSS as a

software package example.Chapter 3 is really a reference section; it discusses the aim of

statistical models, inferential statistics and significance. It then goes on to describe and outline

the main statistical analytic techniques used in this book; it sets out when certain analytic tests

should be used in what context. We also briefly show where to find these analyses options in

the SPSS menu system. New to the second edition, we add an Appendix R at the back of the

book which provides the R syntax that maps onto the SPSS analyses options presented in

Chapter 3.Chapters 4–9 are all case study ‘meat and bones’ chapters: Chapter 4 – diversity

analysis; Chapter 5 – employee attitude and engagement data; Chapter 6 – employee turnover

analysis; Chapter 7 – predicting employee performance; Chapter 8 – recruitment and selection

analysis; and Chapter 9 – monitoring the impact of interventions. In each of these chapters we

give a brief introduction to the issues and topic areas and demonstrate a number of ways that

HR-related data can be analysed/modelled in each case. We supply example data sets to be

used in each chapter and walk the analyst through how to run a range of possible analytic

models in each case. Importantly we show how to interpret the statistical results and highlight

some ‘snapshot hidden gems’ that the analytic techniques expose in each case. The example

data sets can be found atChapter 10 is all about applying the predictive models to try and get

the most out of the analysis in terms of ‘predictive modelling’. Here we give examples of the

true potential that predictive HR analytics can bring to an organization.Chapter 11 discusses



and introduces a range of different, more advanced analytic techniques that we do not cover

but feel it is important for the budding analyst to get a conceptual understanding of their

potential.Finally, in Chapter 12 we end the book on a reflective note: the journey of HR

analytics is fraught with obstacles and potential sticky problems – this chapter encourages the

analyst to reflect and think critically about the predictive HR analytic project, with the aim of

ensuring that the analyst does not carry out HR analytics without considering the limitations

and ethical challenges that the activity raises. We also consider the impact of the European

General Data Protection Regulation introduced in May 2018.As mentioned above, one of the

new aspects of this second edition includes an appendix (R) that shows how you can run the

main analyses in our book with R. We also provide a folder download on the Kogan Page

website () that R users can use to run the statistical analyses that we present throughout the

book.By the end of the book the HR analyst should have gained considerable experience of

applying statistical models to HR data and should be ready to use their analytic capabilities

and set sail into their own organization’s ocean of people-related data.Bon voyage!
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book.01Understanding HR analyticsArguably the most practical tool and greatest potential for

organizational management is the emergence of predictive analytics.FITZ-ENZ AND MATTOX

II (2014)Analytics present a tremendous opportunity to help organizations understand what

they don’t yet know… By identifying trends and patterns, HR professionals and management

teams can make better strategic decisions about the workforce challenges that they may soon

face.HUSELID (2014)Since the first edition of this book was written (and published in 2016) the

field of HR analytics has seemingly gone from something that was beginning to attract a great

deal of interest to, what can be now be considered, an important (if not essential) aspect of

what should be included in the offering of any sophisticated HR function. There has been some

speculation about what is the best name for the specialism (see Edwards, 2018), with some

preferring workforce analytics or people analytics to HR analytics.Figure 1.1 shows the growth

of interest in the area, based on internet searches; clearly, the plot lines are only going

upwards over recent years! The key word that we can associate with the field is ‘growth’! In the

past few years we have witnessed a considerable growth in the number of HR analytics

practitioner conferences, training courses, consultancy offerings, books (e.g. Levenson, 2015;

Edwards and Edwards, 2016; Guenole et al, 2017) and academic papers (e.g. Angrave et al,

2016; Marler and Boudreau, 2017 and Kryscynski et al, 2017). The quotes at the top of this

page are as relevant now as they were at the time that the earlier version of this book was



published. It is becoming quite clear from the narrative, blogs and articles that are being

published around HR analytics that, as a field, it is becoming an increasingly important part of

the HR sphere.Figure 1.1 Plot of internet search interest of HR analytics subject words from

2004–18 (graph produced by Paul Van der Laken, 2018, p 18)There have been calls by some

to ensure that the HR function moves away from introducing ‘copycat practices’ to ‘promoting

practices and advising the organization’s leadership’ through an assessment of available data

and research linked to the particular issue at hand (Rousseau and Barends, 2011); HR

analytics, with its natural emphasis on relying on data and research to help answer business

questions, helps to answer this call. The reality is that, even though many HR professionals

may have a conceptual understanding of what HR analytics might involve, very few people

have the relevant competencies to be able to actually carry out sophisticated predictive HR

analytics. Whilst more skilled analytic experts are moving into the HR analytic field, and the

importance of analytics competencies for the function is now being recognized (Kryscynski et

al, 2017), there is some way to go before the HR profession has the necessary level of analytic

competency to fully utilize the potential of HR analytics. This book aims to help people develop

these competencies and to demystify what may (for many) currently be hidden behind the

‘magic curtain’ of HR analytics. The book hopes to metaphorically pull back both curtains and

give potential analysts a foundation of tools to tie them securely to the wall. Before we go on to

discuss and help demystify HR analytics, it is important to define our terms and set out our

stall as to what we mean by ‘predictive HR analytics’.Predictive HR analytics definedWe define

‘predictive HR analytics’ as: ‘the systematic application of predictive modelling using inferential

statistics to existing HR people-related data in order to inform judgements about possible

causal factors driving key HR-related performance indicators. The results of this modelling can

be used (where appropriate) to make tangible predictions about particular results or people

outcomes’.Put simply, we take the sophisticated statistics and quantitative analyses techniques

that scientists use to predict things (such as what may cause heart disease or what might help

to cure cancer) and apply them to the information we hold about people in organizations. This

enables us to test statistical models and predict things such as what might drive high

performance or what might cause an employee to leave the organization. Furthermore, where

appropriate, we can also then apply these predictive models to make tangible predictions

about particular results or outcomes (eg employee or organizational behaviour) that we might

expect to find, given certain conditions.Being able to apply predictive statistical models to HR-

related data requires some knowledge of statistics and the capability (and experience) to

understand and interpret meaning behind results that analyses are telling us. At the moment

(as discussed in various places within this book), very few HR functions actually utilize the

statistical analytical techniques that are available to them. More often than not, whilst HR

metrics and HR analytics teams do (at the moment) process and report on vast amounts of

people-related data, very few apply statistical techniques that enable predictive inferences to

be made. This is as much the case now (2019) as it was at the time of the previous edition of

this book (2016).It is worth noting here that predictive modelling is sometimes associated with

computational data science techniques linked to big-data analyses and machine learning.

However, many techniques underlying such applications rely on the statistical techniques that

we present in this book, for example regression analyses that produce algorithms to make

predictions (see Chapter 10). As the statistical techniques presented here cover a wide array of

possible techniques that an HR analytics expert might use, understanding these statistical

tools and how they apply to HR data provides a deep foundational basis for any budding HR

analytics professional.Understanding the need (and business case) for mastering and utilizing



predictive HR analytic techniquesHR information and management information (MI) teams

currently spend considerable time and effort producing descriptive report after descriptive

report – monitoring them, comparing them across geographical boundaries and over time

periods, but often doing very little else with the report other than producing it – again and

again. Descriptive HR reports usually produced by MI teams will generally only present a

picture or ‘snapshot’ of what is occurring in the organization at that particular time. Whilst there

is little doubt that these reports are useful to the business in ensuring that managers

understand what is going on within the organization, there is a real limit to what these reports

can tell us. Descriptive reports do very little more than describe what is happening; they lack

the capability to help understand and account for why things are happening in the organization.

Furthermore, when running these reports, the analysts generally fail to interrogate the data

fully for other possible explanatory factors (which can help clarify why something might be

happening). They also tend to fail to test or check the degree to which their data might be

robust and valid. Furthermore, descriptive reports do not in any way help us to make

predictions about what we might find in the future. It is this ability that differentiates predictive

HR analytics from the analysis currently carried out by the majority of HR MI teams.Experts

such as Bersin (2012) outline the importance of using predictive analytics to help organizations

predict and understand the performance of a person (or indeed a group of people) based on

available historical data. Once that sufficient people-related data has been collected over time,

it is then possible to analyse patterns and trends based on this historical data. As quoted in the

epigraph to this chapter, in 2014 Huselid argued: ‘Analytics present a tremendous opportunity

to help organizations understand what they don’t yet know… By identifying trends and

patterns, HR professionals and management teams can make better strategic decisions about

the workforce challenges that they may soon face.’ Predictive HR analytics therefore offers the

opportunity to help model and analyse historical data and interrogate patterns in order to help

understand causal factors and do exactly what Bersin and Huselid are suggesting is

important.Knowing what has happened in our organization and having evidence for why things

have happened, in particular what the drivers are of certain behaviours within our organization,

will undoubtedly help us to make better decisions. For example, if we can identify predictors of

things like high performance, productivity increases, staff retention, higher employee and team

engagement, then this information gives managers a good steer as to what strategic activities

to invest in to help lever important employee outcomes.Human capital data storage and ‘big

(HR) data’ manipulationTo be able to realize the potential of predictive HR analytics all of us

are reliant upon what current and historical data is available. Predictive HR analytics relies

completely on good data; we cannot look for patterns in data when the available data is limited

and sketchy. Thus the success of HR analytics is completely reliant on the availability of good

people-related information. As we discuss in Chapter 2, increasingly HR functions are not

necessarily faced with the problem of there being a lack of data available – they are often faced

with the problem that there is too much data to know what to do with. Much has been talked

about in the popular and practitioner press about ‘big data’ (we discuss this in Chapter 2). Thus

a challenge often faced by an HR analytics team is what to do with all the people-related HR

data that is available. Once we have sufficient HR-related data, one of the biggest challenges is

getting that data into the right format for analysis (we walk through an example of this in

Chapter 2).Useful HR-related data is made up of many different types of information and might

include the following:skills and qualifications;measures of particular competencies;training

attended;levels of employee engagement;customer satisfaction data;performance appraisal

records;pay, bonus and remuneration data.It takes time and considerable manipulation of data



files to make sure that the models run are appropriate to the type of data available, so Chapter

2 talks more about systems and data, and Chapter 3 will help you to determine which models

to run for which circumstance. Ultimately, the data available (and the data that is missing) is the

key determining factor on what kind of analysis can be carried out and what business

questions can be answered. The other important factor is respect for the ‘head space’ required

to be able to fully engage with the data, the analysis, and what it all means for the

organization.Predictors, prediction and predictive modellingBy definition, central to the idea of

‘predictive’ HR analytics is that something can be ‘predicted’. One of the critiques sometimes

posed at predictive HR analytics is that the ‘predictive’ part is very rarely realized. Obviously, if

the future was known by an organization then this would be extremely useful and managers

would be able to make strategic decisions in order to exploit it. Presumably this is one of the

reasons why ‘predictive analytics’ as a term has become so popular. However, in terms of

analytics, there are a number of ways that we can use the term ‘predictive’ and it is worth

distinguishing this at the start so that we can be comfortable with our use of the term in this

book (and indeed the title of the book!).One of the ways that we (and others) use the term

‘prediction’ is related to the idea of identifying ‘predictors’ or potential ‘causal’ factors that help

explain why a particular feature or measure shows variation (eg why performance levels vary

amongst employees). As we explain in Chapter 3, some of the analytic techniques that we use

aim to explore relationships between many different types of data (or variables) in order to

identify ‘predictors’ of some important HR outcome (such as employee performance or staff

turnover). This type of analysis is used to identify trends and relationships between multiple

factors with the hope of obtaining information that suggests the possible causes of variation in

the phenomenon that we are hoping to predict. Assuming that we find a range of significant

features of our people-related data where variation is associated (in a unique way) with an

increase or decrease in what we hope to account for, we can say that we have found potential

‘predictors’. In this context one can also refer to these predictors as potential ‘drivers’ of our

outcome. Importantly, the use of the word ‘predictors’ here implies that we seek out and have

found potential ‘causes’ of variation on the feature we are trying to predict (see Chapter 12 for

our discussion of causality and challenges of assuming that relationships found in data imply

‘causality’). Almost all of our case study chapters (Chapters 4–9) utilize analytics that relate to

this form of the word ‘prediction’.A second use of the term in the context of ‘predictive HR

analytics’ is the use of ‘predictive modelling’. Here, we take features and findings of our

analysis (for example, where we identify a series of factors that were related to variations in

staff productivity or sales), then we apply our model to help demonstrate or ‘predict’ what would

happen to our key outcome variable (eg staff productivity or sales) if we could do something to

change or adjust the key drivers that we have identified. We demonstrate this use of the word

‘prediction’ in Chapter 10.Finally, a third use of the term ‘prediction’ that we can use in the

context of ‘predictive HR analytics’ is that we can translate the findings from our ‘predictive

models’ where we identified ‘predictors’ of variation in our particular outcome variable (eg staff

productivity or sales) and use the resulting model to ‘predict’ how current or future employees

(or teams) may behave (eg staff productivity or sales) in the future. We also demonstrate this

use of the word ‘prediction’ in Chapter 10 where we show how, through identifying patterns and

trends in existing data, you can apply a particular algorithm to newly collected information so

as to provide evidence-based predictions of possible future behaviour that can help managers

to make a decision.Importantly, this book can help provide a ‘walk-through’ and demonstrate to

students of HR analytics how they can apply statistics in order to fully utilize all aspects of the

promise that the term ‘predictive HR analytics’ implies.Current state of HR analytic capabilities



and professional or academic trainingAs mentioned, the field has moved on considerably since

the previous edition of this book; there now seems to be a much greater availability of HR/

people analytics training providers that service the professional HR community. In 2016 there

was an obvious scarcity of this, but a number of academic institutions are now including HR/

people analytics modules in their teaching. There has also been a general growth in data

analytics and business analytics academic programmes available.We discussed previously

how HR training provision generally does not tend to include either intermediate or advanced

level quantitative analyses; ultimately, there are no general expectations that HR should include

analytics, and it is often the case that students can get to an HR Masters level without having

ever been trained in statistics. Certainly, the vast majority of people who enter the HR

profession (in the UK at least) do not have the required skills to be able to carry out any

sophisticated predictive HR analytics. The level of analytic skills that HR graduates possess will

often be dependent upon the degree that they studied at undergraduate level; for example, an

undergraduate degree in a traditional discipline such as economics, mathematics or

psychology would have statistics as a substantial part of the degree content. Within many

countries, even when students have come from a business or management degree, such

students can often sidestep statistics (almost) completely. Up until 2018, HR may have been

seen by some students as a ‘safe haven’ from numbers. In addition to this, many HR

professionals move into HR without formal academic training and are unlikely to have had any

formal training in statistics. If we take the UK as an example and we look at the competency

requirements for membership into the Chartered Institute of Personnel and Development

(CIPD) up to and before 2018, even with advanced-level module expectations there was very

little requirement that candidates develop numerical abilities (let alone statistical abilities). At

the time of writing, the authors have been informed that the CIPD is preparing a new set of

professional standards and quantitative skills will be included in this to a greater degree.Recent

research, however, is beginning to show how important analytic competencies are in the HR

profession. Kryscynski et al (2017) showed a positive relationship between ratings of analytic

competencies and ratings of performance from a number of stakeholders. However, Minbaeva

(2017) reports on a Deloitte (2015) survey that indicated 75 per cent of companies surveyed

indicated ‘human capital analytics’ was important for business performance but only 8 per cent

had strong capabilities. A recent CIPD survey of the state of HR analytics in the profession

showed considerable geographical variation in HR capabilities with advanced analytics, with

only 21 per cent of UK respondents stating that they had confidence in conducting advanced

analytics (and only 6 per cent indicating that they use these regularly).In terms of how an HR

team gets the competencies required to conduct advanced analytics, there is a debate about

how best to set up an HR analytics offering/team (Rasmussen and Ulrich, 2015; Edwards,

2018) and often data scientists/quantitative scientists who do not originate from the field of HR

are an important resource to draw upon to include in the HR analytics team. This is mainly

because HR specialists rarely have the requisite skills, even though there is a perceived need

for the HR profession to have these capabilities. This skills/capability gap is, however,

something that this book hopes to do something about! Whether the HR professional is a

generalist, a specialist in one particular area (such as talent, diversity or engagement), or the

head of HR for a large multinational organization, the ability to identify and understand trends

and patterns, to take bias and gut instinct out of decision making, and to predict organizational

challenges is something that will set them apart in becoming a credible, high-performing HR

professional (helping the organization to be more successful). This competence gap needs to

be addressed if the HR profession is to fully exploit the opportunities that Huselid is alluding to



in the quote at the beginning of this chapter.Importantly, one of the key aims of this book is to

help educate HR students and practitioners so as to help have a positive impact on the

profession as a whole by adding to the quantitative literacy of people within it. Of course, in

trying to achieve this aim, we will always be confronted with the phenomenon of many people

having an automatic ‘off switch’ when it comes to statistics. This is no doubt why books out

there have titles such as Statistics for people who think they hate statistics and Statistics

without tears, etc. We argue, and truly believe, that having a strong quantitative analytic

capability and knowledge of statistics will provide a firm foundation for any HR professional.

Thus, mastering the HR metric by learning to carry out predictive HR analytics will

fundamentally strengthen the skillset of the profession.Business applications of

modellingAlmost all of the analyses presented in this book will have significant business

implications and application; sometimes this is obvious and sometimes this requires a careful

consideration of the results of the models tested. One of the things that the HR analytics team

will need to be able to do, as a matter of course, is to be able to translate analysis findings to

potential business applications. We discuss this in Chapter 10 where we give some examples

of translating our predictive models to specific applications. However, we only touch the surface

of presenting examples of ways in which the analytics in this book could be translated to

specific business applications. Importantly, any HR analytics team should instil a mentality of

always looking to answer the ‘So what?’ question (one that they will inevitably be asked when

presenting their analytic results). The analytics team need to be always on the lookout for how

their findings could be translated to useful practice knowledge, and whether any particular

knowledge gained can help to strengthen and steer the organization’s people strategy.HR

analytics and HR people strategyIn learning and applying the methods outlined in this book, it

should become obvious to the analytics team that it is possible to use analytical models to help

steer, adjust and even drive business strategy. Ultimately the analytics approaches

recommended can provide evidence-based pointers for practice and can help take some

emotion and gut instinct out of ‘people’ decision making. Methods such as those described in

all of the case study chapters should be able to help highlight key strategic factors to focus on

when devising a people strategy plan, and the methods outlined in Chapter 9 (monitoring the

impact of people interventions) will assist the HR function in tracking and monitoring the

success of their people plan (proving opportunities for reflection and adjustment to the plan).

We discuss how to use predictive models to improve performance, turnover and hiring

decisions – essential areas of HR on which the success of the function is measured. Hopefully

the methods discussed in this book will assist HR analytics teams and their organizations to

make sound, evidence-based people decisions that will help the organization to prosper – and,

in doing so, value the HR function.Becoming a persuasive HR functionThe development of

HR’s strategic role has been an evolution… The next step in the evolution is for HR

professionals, and particularly senior HR professionals, to develop what we call analytic

literacy.HUSELID AND BECKER (2005: 279).As you work through this book, you will begin to

understand the opportunities that can open up for answering business questions, even those

that have not been asked yet! We believe that this ‘analytic literacy’ will help transform the HR

function. An HR function that fully utilizes predictive HR analytics capabilities will be more

credible because the function will be able to present robust ‘hard’ evidence to show that it has

a good understanding of what makes its people tick, along with knowledge of who is likely to

perform well, who is likely to leave, which parts of the organization are showing race or gender

bias, which candidates are likely to be successful in the organization, and which interventions

had a significant impact on the organization and which did not. The function will be able to



carry out substantial ‘what if’ scenario modelling to help build solid business cases that help

the organization to make decisions around whether particular investments are likely to be

worthwhile, and what the return on those investments are likely to be.By systematically going

through this book and the exercises provided, any developing HR analytics team should have

increased their capabilities and learnt many things that will help them to become Masters of
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information systems and dataWe hope that Chapter 1 has given you a good understanding of

the benefits that predictive HR analytics techniques can bring to an organization. Before we get

into the actual analysis piece, it is worth taking time out to understand the lay of the land. What

type of data do you have in the organization already: what illuminating nuggets of information

may be hidden on a spreadsheet in a colleague’s personal folder, or the sales database, or the

learning and development (L&D) records that could all tell a story when the pieces come

together?To illustrate with a simple example, looking at the customer satisfaction survey results

alone can provide some useful information about how our customers feel about our customer-

facing staff. It is difficult, though, to determine prescriptive action that should be taken from



customer satisfaction survey results by themselves. If the results are poor overall, we may

issue a guidance paper to all customer-facing staff. If, however, the data is linked to L&D team

records, we might find that staff who attended a relationship management course in the

previous quarter obtain the best customer service results. Or if we link it to our client profile

information, we might find that it is our ethnic minority clients in branches outside major cities

that are most dissatisfied, suggesting that we may need to provide some unconscious bias or

diversity awareness training. The more relevant information we have linked, the better chance

we have of understanding the big picture of what is actually going on, which in turn means the

better chance we have of correctly diagnosing a problem and prescribing a solution that will

work – we don’t want to spend time and money putting a plaster cast on the entire foot if all

that is broken is the middle toe.In this chapter, we look at:information source examples: what

you are likely to find and where;the software: a short review of analytics software

packages;using SPSS: becoming familiar with the SPSS environment;preparing the data: what

the data looks like, getting it into SPSS and preparing it for analysis;big data: what it is and why

it is valuable to organizations.While it would be impossible to list all of the possible information

sources in all organizations, the next section looks at what many organizations are likely to

have and may give you ideas on where to look.Information sourcesThe information available in

the form of data to be analysed will vary greatly depending on the type of organization. In this

book, we look not only at the data typically managed by an HR department, but also important

customer satisfaction and operational data that is key to running a successful organization. The

key is not to be limited by what is immediately available in the HR department, even if you are

in an HR role. It is when the information is expanded, linked together and analysed with

rigorous statistical techniques that we find what is truly happening in our organization. Some

examples of the types of data we consider in this book are outlined in Table 2.1.Table 2.1

Information source examplesInformation SourceDescriptionExampleHR database (such as

SAP or Oracle)Information describing the employee across a wide range of people-

management activities, including employee personal details, performance, diversity data,

promotion information. Further information on data protection and storage of personal data can

be found in Chapter 12 (Reflection on HR analytics: Usage, ethics and limitations).Age, gender,

education level, role, salary, performance ratings, disabilities, tenure, sickness absence, leaver

information, country location, team leader, etc.Employee attitude survey data (often stored in

survey programmes and exported to Excel)Survey results from annual employee attitude

surveys. Either managed in-house or with an external survey provider organization. Typically

containing employee engagement data. The information will depend purely on the questions

asked in the survey; however, the examples to the right will give an idea of what can be

included. Further information on employee engagement and survey data can be found in

Chapter 5 (employee attitude surveys – engagement and workforce perceptions).Job-strain

level, employee engagement, job satisfaction, person – organization fit and perceptions of

justice.Customer satisfaction survey data (often stored in survey programmes and exported to

Excel)Often run by marketing or sales functions, customer satisfaction survey data often

provides extremely useful information about customer preferences and, when linked to

employee profile and operational data, can help organizations to identify how changes to

employee skills and behaviours, as well as any operational or process changes, can have a

direct impact on the customer experience. Further information on employee engagement and

survey data can be found in the employee engagement case study in Chapter 5.Customer

ratings on specific services, branches and customer-facing employees, customer loyalty,

customer preferences, customer satisfaction, likelihood of further business.Sales performance



dataInformation usually owned by the sales function, recording details of sales performance

and revenues. This information is key to determining organizational revenues and the success

or otherwise of salespeople and teams in meeting targets. When linked with employee data

and operational information it can also help determine the conditions under which salespeople

and teams are more likely to succeed or, put another way, what individual or team

characteristics tend to make for a more positive bottom line.Average monthly sales, number of

new customers introduced, meeting or not meeting target, individual or team daily, weekly or

monthly sales.Operational performance dataInformation or data measuring the successful

running of the business. Usually referring to efficiency.Supermarket scan rates, call-centre call

durations, average number of calls dropped out, average number of queries resolved on first

contact, time taken to onboard a new customer, etc.By linking data sources and thinking

broadly across the whole organization, we are able to model organizational patterns of

behaviour and link HR and people-management practices directly with revenue and efficiency.

In order to link and analyse the information available with ease, we need to use a statistical

analysis package, of which there are many available on the market.Analysis software

optionsThere is no shortage of statistical software programs and, because many of them are

prohibitively expensive for individual users, the one you use is likely to be determined by the

organization or university you are currently involved with. The good news is that there is lots of

overlap between the packages, and the analyses generally produce the same core output;

once you learn one, it is relatively straightforward to transfer those skills to another system. So

although in this book we only use SPSS for our examples, the skills you learn and the analytic

methods we take you through may be applied in most other systems. Here are a few of the

common analysis software systems that you are likely to encounter and some details

according to an online review by a stats expert (Kane, 2012).SPSSSPSS is a very user-friendly

statistical package (which is the main reason we use SPSS in our examples in this book) with

a graphical user interface and a point-and-click menu for running procedures. It is relatively

easy to learn and, although it does have the option for coding syntax for the more advanced

user, it is the clear leader of all the statistical software packages in its ability to run many

complex procedures by using the mouse and menus alone. Although SPSS does not cover all

statistical procedures, it does cover what is required by 95 per cent of users (and each new

version seems to have more and more options). SPSS is a great package for being able to

transfer output to other formats for reports. Although it can sometimes be slow at processing

very large amounts of data, SPSS is good for extracting subsets of smaller data for analysis

and the process to do this is relatively simple to learn. Once you have the data loaded into

SPSS, a great benefit is the ease at which it is possible to manipulate that data (eg to relabel

and create new variables, etc).MinitabMinitab also has a user-friendly menu-based user

interface for running procedures and has been noted as the simplest package to learn. Like

SPSS, Minitab enables users to do most analysis procedures without having to understand the

coding syntax. It does not cover all statistical procedures, but does cover what is required by 95

per cent of users. In terms of manipulating data, once the data is in Minitab, it can sometimes

be difficult to change (Kane, 2012). It can also be difficult to transfer output to other formats for

inclusion in reports.StataAlthough Stata does have some menus, it is primarily command-line

driven and hence takes a bit longer to master. Stata does offer a more comprehensive range of

statistical procedures and is often used by economists. It is quite good at being able to

manipulate data once it is in the system; however, the user will need to learn the command-line

interface systems in the first instance. On the negative side, it can be difficult to transfer data

and output to other formats for reports (Kane, 2012).SASSAS is primarily a command-line-



driven package with relatively few menu-driven procedures. For this reason it can take some

time to master. It is a very powerful package and offers a more comprehensive range of

statistical procedures than the others discussed here. It is also the leader in being able to

handle large amounts of data, which could be pertinent depending on the type of organization,

and particularly relevant considering the section on ‘big data’ later in this chapter. It is also

possible to extract small subsets of large data quickly. Finally, it can also be difficult in SAS to

transfer output to other formats for reports (Kane, 2012).RAn exciting thing about R is that it is

completely free and the community of developers is constantly adding functionality to enable a

wide range of statistical analytic tools. R is command-line syntax driven, which requires a fair

amount of learning time in the first instance; it does have a menu-driven user interface as well

but this is rather limited. Ultimately, R users need to learn how to use the syntax interface to

fully utilize the benefits of R. The nature of the user interface, however, does mean that it is far

more difficult to learn than SPSS or Minitab – you basically have to learn the rudiments of a

programming syntax language. Thus the learning curve is very steep at first and you have to

get to grips with the basics of R syntax before you can run even the most basic statistical

analyses. Also, with R, you do not see and manipulate a data file in the same intuitive way as

you do with SPSS; with SPSS you literally see your data all the time and can see any changes

that you have made to this.R is one of the leading packages when it comes to the range of

statistical procedures offered, however. R has a fair amount of statistical utility built into the

program; however, one of the features when using R is that you can install additional analytic

packages into the program (for free), which vastly broadens the scope of analytic tools that it

can handle. Thus once you have learnt the basics of R (and started building a library of syntax

to help you with your analyses) you can keep adding elements that broaden its (and your)

capabilities. You can, for example, go as far as running machine learning with R.We include a

set of R syntax in Appendix R (page 495) of this second edition that can be used to run the

main statistical procedures that we outline in Chapter 3. We also provide examples of R syntax

that enable you to run all of the SPSS statistical examples in the book as a PDF and file

download on the Kogan Page website (). Thus this new edition can help SPSS users extend

their capabilities to run the models presented in the book with R; it also enables R users to run

the models presented in the book with R.It is worth noting that 95 per cent of users of

statistical software packages – and arguably HR analytics professionals – could get what they

need from packages such as SPSS and Minitab, which are far more user friendly. However

they may at some point reach a limit of capability, which generally does not happen with R, as

there will often be a package that you could install into the program. Kane (2012) also notes

that the graphical output that R produces ‘pretty much blow[s] away anything that seems

feasible in other packages’. While it may have the best data importation facility of all the

packages, it is said to struggle with very large data sets (Kane, 2012). Finally, it requires

command-line edits in order to manipulate the data once it has been imported. Its usage has

grown over recent years because of its ‘free’ nature and the fact that its functionality is growing

with further developments. The steep learning curve required to get off the ground can be a big

inhibitor (and be intimidating) for those who are learning statistics at the same time as trying to

learn R. Having said this, R users tend to get very enthusiastic about the program and there is

a big support community of R users in the net that readily share R learning

resources.JASPJASP is another open source/free statistics program. Still a new player at the

time of writing this second edition, JASP supports many of the classical statistics methods we

cover in this book, as well as some Bayesian statistics methods. It is very user friendly and has

some nice reporting features as well as helpful videos available to users. Whilst the



functionality is somewhat limited, beginners will find this a useful tool. See .JamoviJamovi is

another new, very exciting and free statistical program. It mainly has a Windows interface but

can also incorporate an R code interface. At the moment there are some limitations to the

analytic tools available but the programmers are adding new functions regularly. You can add

analytics utilities to it (that are available) and this includes some very useful extensions. There

are restrictions to the analyses options in places, which create some limitations, but for a free

package you can run many models using a simple user interface.PythonPython is one of the

leading programming languages and, similar to R, it is based on command line syntax. This

means that, unless you have experience with programming languages (in which case you

would find it quite easy to learn), there is a steep learning curve to begin with compared to

systems with user-friendly interfaces like Minitab and SPSS. Its application, however, is wide-

ranging and it can be used for traditional statistical analysis as well as for machine learning.

Python is also free to download and there are many online communities for experienced and

new users alike.Unlike R, which was designed with specific features to support statistics and

data analytics, Python is more of a general purpose programming language and hence its

functionality is more wide-ranging. Python is also reported to be much faster than R and the

learning curve less steep.Using SPSSAlthough there are many statistical software packages

available on the market, for the case studies outlined in this book we have decided to use

SPSS. Why? Largely because it is the one we have most experience in; it is also one of the

most ‘user friendly’. If your university or organization uses different software, don’t worry, you

will still find the case studies and analysis useful – indeed the analytic methods outlined in

Chapter 3 are the same regardless of the software (and we provide the R syntax for these in

Appendix R, page 495). If, in our case study example, we recommend a particular form of

analysis and discuss results, a user familiar with another program should be able to translate

these examples to another package with relative ease. Importantly, the essence of the output

should be the same across all packages (we have made every effort to present the R syntax

and commands in Appendix R and file download examples that mirror the key SPSS output

produced in this book). Also, once you get to know one statistical software package, it is much

easier for you to learn a second one – because you are essentially trying to do the same thing.

It is the work beforehand – knowing which test or which procedure to run – that is where the

real skill comes in. Chapter 3 (Analysis strategies) will walk you through the steps in

determining which statistical test to use in which situation. It is also worth noting that the

screenshots and menu commands used in this book are based on SPSS version 25.0

(Mac).The first thing you will notice about SPSS is that it has two windows: the data view and

the variable view.The SPSS data viewThe SPSS data view has a similar appearance to a

Microsoft Excel spreadsheet. You can either enter the data manually or import it from another

source. This is the screen where you can view and edit the raw data (see Figure 2.1).Figure

2.1In the data view, we have the following key pieces of information:Each row is a ‘case’, which

for much of the work we do in HR analytics would be an employee (or possibly another object

entity such as a team if the data set represents team-level data). When the data is linked to

individuals, you could think of each row as storing all information on each employee.Each

column is a ‘variable’, which represents a characteristic or attribute of the employee, such as

age, gender or performance rating.Each cell is then a value. It shows the value of the variable

for the case, or the value of the attribute for the employee: for example, 42 years old, female,

with a performance rating of 5.So, in many examples in HR analytics, there will typically be one

row for each employee.Helpfully, data can be cut and pasted to and from SPSS and Microsoft

Word or Excel.The SPSS variable viewWe talk about the different types of variables in detail in



Chapter 3, but for now we can just focus on setting up the names and characteristics of the

variables. As for the names of the variables, we can think of these names as the column

headings in the data (similar to Excel). Just as we are able to format the cells in a spreadsheet

to be a number, currency, date, text, etc, we can also set the variable attributes in SPSS; we do

this in the ‘variable view’ (see Figure 2.2).Figure 2.2When you switch to the variable view (by

clicking on the ‘Variable View’ tab at the bottom of the screen; see Figure 2.2) you will see that

this view shows us all the variables and their attributes. Here each row represents a variable,

and each column is a variable attribute. In the variable view we can add, delete and modify

variables. When we add a variable, the attributes we need to set and how this is done are

outlined below.Variable nameThe variable ‘Name’ cell (see Figure 2.2) is where you enter the

name of the variable: you simply type this into the cell. SPSS can be a bit picky about the

variable names so you may find that you type in a name you are happy with only to be asked to

change it. If you keep to the following basic rules, though, you will be okay in most cases:Make

sure each variable name is unique. This makes sense – we would get confused about which

one you were talking about if you had duplication.Do not have any spaces in the variable

name.Stick with the alphabet. If you do use numbers and symbols, make sure they are not the

first character.TypeThe variable ‘Type’ cell (see Figure 2.2) is where you enter the data type of

the variable, similar to in Microsoft Excel where you select whether the cell is a date or a

number, etc. Once you click on the Type cell in the variable view you will see the box presented

in Figure 2.3.Figure 2.3In most cases in HR analytics, you will be working with numbers

(‘Numeric’) as in the values for a variable measure such as ‘age’ (eg 46, 55, etc), or text values

such as the variable ‘employee first name’ (eg Joe, Mary, Bob), or a date, such as ‘start

date’ (eg 24/07/2015). It is important to set these up in the variable view before entering any

data.WidthIn the variable ‘Width’ cell (see Figure 2.2) you simply enter the number of

characters used to display the data. A ‘Numeric’ will default to 8 and a ‘String’ will default to

16.DecimalsIf the data type is numeric, the variable ‘Decimals’ cell (see Figure 2.2) is where

you can enter the number of decimal places you would like. This is similar to the equivalent

function in Microsoft Excel. For example, if you enter 2 here, then any value would be stored

with two decimal places, eg 6.05.LabelThe variable ‘Label’ cell (see Figure 2.2) is where you

can enter a textual description of the variable. This can be much longer than what you entered

in the Variable Name field. In the case of an employee engagement survey, often the whole

question is entered, eg ‘When I get up in the morning, I feel like going to work’. This example is

used in the ‘engagement’ case study (Chapter 5) as a measure of ‘vigour’, which is the variable

name. It is part of a set of questions where the participant is asked to answer how much they

agree or disagree with the statements on a scale of 1 to 5.ValuesGenerally in HR analytics

statistical modelling we will use numeric values to represent categorical variable labels. See

Chapter 3 for a more detailed explanation of categorical variables. What we mean by this is

when, for example, a value of 0 may represent ‘female’ and a value of 1 may represent ‘male’.

We sometimes do this because representing the values as numeric in this way opens up a

whole world of analysis that we would not otherwise be able to carry out were we to use the

text (or ‘string’) value. Another example might be to enter performance rating meanings; for

example: 1 = very poor performer; 2 = does not meet expectations; 3 = meets expectations; 4 =

exceeds expectations; 5 = superhuman. If, while viewing the data in data view, you wish to view

the categorical value to see the true identity of the value rather than the number, you can flip

between the two using the button shown in Figure 2.4. You can also do this by using the menu

items – View -> Value Labels.Figure 2.4MissingDepending on the source of the data we have

entered or imported into SPSS, we may have some values in there that should actually be



treated as missing data. For example, a convention exists where the value ‘99’ or ‘999’ may

actually represent the ‘null response’ value from another system; 99 or 999 is sometimes used

to represent missing values as they will be meaningless with certain variables (that only have

one character). If we know what these missing data labels are, we can tell SPSS to treat these

as missing data (ie they will be ignored), rather than treat them as the actual values in that

place. You can set these in the variable ‘Missing’ cell (see Figure 2.2).ColumnsIn the variable

‘Columns’ cell (see Figure 2.2) you can use the up and down arrows to set the width of the

column for when the data is being viewed in the data view mode.AlignIn the variable ‘Align’ cell

(see Figure 2.2), this is simply where you set the alignment of the cell in data view mode, ie left

or right justified, or centred.MeasureIn the variable ‘Measure’ cell (see Figure 2.2) you can

describe the ‘level’ of the measurement, which we can set to be nominal, ordinal or scale. If the

values describe different categories of something that has no particular order, for example eye

colour (blue, green, brown, black, hazel, grey, etc), then we would say that the data is nominal.

If the data values describe different categories of something that does have an order, for

example, salary band (band a, band b, band c) or performance rating (1, 2, 3, 4, 5) where we

can look at increases and decreases, we would call the data ‘ordinal’. If, however, the value is a

continuous number, and not necessarily whole numbers, such as that which we would

measure on a scale, for example 23.5 degrees Celsius, 124.6 miles, 46 kilogrammes, this data

would be called ‘scale’ data.Once you have set up variables in the variable view, you can either

enter data directly into the data view, or import data from another file.Preparing the dataData

may be typed into the SPSS data view, or it may be imported from an existing file such as an

Excel spreadsheet. See the example below, which will walk you through the process of

entering and importing data.The annual performance review project manager, Remi, has

forwarded you an e-mail he has just received from the marketing team manager containing

some key information about performance results of her team. For each of the five employees

on the marketing team, the e-mail contains the following information:employee ID;performance

rating;salary adjustment (percentage).Until you train Remi and the other managers to enter

data into a spreadsheet (which you will soon see is much easier) rather than an e-mail, for

each manager you will have to go through the exercise set out below. The first step, then, is to

create a new file and enter the data manually into the data view. Remi has at least promised to

be consistent and provide you with the same information from each manager.Setting up

variables in the variable view and entering data manually into the data viewYou will need to set

up each variable first in the variable view before entering the data in the data view. Opening

SPSS will present you with a data view and a variable view. Click on the variable view to begin

setting up the variables.The first variable is employee ID, so let’s call it EmpId in the ‘Name’

column (see Figure 2.5).Figure 2.5In the ‘Type’ column, click on the button with the three dots

(see Figure 2.6) to bring up the Variable Type selection box (see Figure 2.7), select String and

hit OK. Employee ID has both numbers and letters, so we can treat it as a character

string.Figure 2.6Figure 2.7The ‘Width’ defaults to 8, which is fine; we have no decimal places in

a string, so we can leave that also.For the ‘Label’, we need to put a description of the variable,

which in this case is: ‘Employee Unique Id’ (see Figure 2.8); and the rest we can leave as the

default.Figure 2.8Now we can go to the data view by clicking on the tab at the bottom and

entering in the data we have for employee ID. You will notice when you click on the Data View

tab, the header is automatically updated (see Figure 2.9).Figure 2.9We have now set up the

employee ID variable and entered in the data. Now would be a good time to save the data file

by going to the File menu (see Figure 2.10), selecting ‘Save As…’, and choosing the file name

and location (see Figure 2.11).Figure 2.10Figure 2.11Let’s now go to the next variable:



performance rating.Back in the variable view, we can enter the name as ‘Rating’ (see Figure

2.12).Figure 2.12As we did above and then for the variable type we click on the button with the

three dots again to bring up the variable type box and enter ‘Numeric’ (see Figure 2.13). We

need to set the decimal points to 0 and click OK (see Figure 2.14).Figure 2.13Figure 2.14We

can leave width and decimals as the default and then enter: ‘Performance rating of employee’

in the label (see Figure 2.15).Figure 2.15Now we need to enter the value labels, which is

where you will see just how useful this feature is; in the values column for the rating variable,

click on the box with the three dots (see Figure 2.16).Figure 2.16This will open the value labels

dialogue box where you can start to enter the labels for performance ratings. One by one we

can enter in our labels for each performance rating and hit ‘Add’ (see Figures 2.17, 2.18 and

2.19).Figure 2.17Figure 2.18Figure 2.19We can continue in this way until all the values have

been entered (see Figure 2.20).Figure 2.20The rest of the columns in the variable view can be

left as the default. Now when we go to the data view mode, we can enter in the data for ratings

for each employee (see Figure 2.21).Figure 2.21The benefit of entering the rating as a numeric

value rather than as text will be discussed in more depth in Chapter 3 and indeed in the case

study chapters, but for now a simple explanation might be that storing the ratings as numbers

allows us to perform arithmetic and calculate averages. It also allows us to talk about what

causes an ‘increase’ or ‘decrease’ in performance – something we cannot test for if

performance were stored as a text variable.Finally, the ‘Measure’ column needs to be set up as

‘ordinal’. This is because the numbers have an order – because the performance rating

increases as the number goes up. Depending on the nature of the variable, you may also

choose to change your variable to be a ‘scale’ measure type (more on this later).From the data

view window, we can toggle between the view of the numeric value and its description by using

the ‘View’ menu option and selecting ‘Value Labels’ (see Figure 2.22).Figure 2.22This will alter

the view and show the value labels as follows (see Figure 2.23):Figure 2.23The final variable

that Remi had asked the line managers to send through on the e-mail is to indicate the

suggested salary adjustment as a percentage. As before, we go into the variable view and set

up this variable. We can enter the name – here we have chosen ‘SalaryAdj’. The type is

numeric, and because some managers have entered in part percentages we need to set this

up as having two decimal points. We can leave the columns ‘Values’, ‘Missing’ and ‘Columns’

as default and now focus on the ‘Measure’ column. Because the percentage salary increase is

on a scale of 1 to 100, we select the type of measure as ‘Scale’. The variable view now looks

like this (see Figure 2.24):Figure 2.24And, having entered the data into the data view, the

entire data now looks like this (see Figure 2.25):Figure 2.25Now we have turned information

included in an e-mail into a data file in SPSS on which we can perform some useful analysis.In

reality, and depending on the size of the organization, Remi (or Remi’s equivalent in any

organization) may send us 10 or 50 or 100 e-mails just like this one. This is when we can then

highlight to Remi that SPSS actually has a wonderful data import facility and that it would save

a lot of time if the data was received in one spreadsheet rather than many e-mails (but we can

thank him for sending the first one in this way because it gave us a chance to test out how the

manual set-up facility works in the data view and the variable view).Copying data from an Excel

spreadsheet into the data viewLet’s say that, the day after Remi sent the initial e-mail above,

he has now seen the error of his ways and sent us the remainder of the information from the

three remaining departments collated together in a spreadsheet that looks like this (see Figure

2.26):Figure 2.26As a nifty trick, we can actually just copy and paste the data element into

SPSS. We simply select the data we want (see Figure 2.27), like this:Figure 2.27Copy this onto

the clipboard in Excel by selecting Edit -> Copy or using the right mouse click, then flicking



back to SPSS and paste this in under the data we already have by using Edit -> Paste (see

Figure 2.28).Figure 2.28The data from the Excel spreadsheet will simply be copied into the

data view. It should now look like this (see Figure 2.29).Figure 2.29So now we have all the data

from the performance review into SPSS and have worked through the examples of how to set

up variables and enter data manually, as well as how to copy and paste from Microsoft

Excel.Loading a complete data file from another source into SPSSAnother way to get data

from a different source into SPSS is to use the menu commands to open and convert a data

file. This is particularly useful if you have not already set up the variable view and are starting

from scratch. Let’s say we have another spreadsheet that contains HR profile data, including

name, age, gender, start date and department. This information may have been exported from

an HR information system such as Oracle or SAP. The spreadsheet may look like this (see

Figure 2.30):Figure 2.30To import this saved file into SPSS, we open SPSS, drop down the

File menu and select File -> Open -> Data (see Figure 2.31).Figure 2.31This will then open up

the ‘Open Data’ dialogue box from where we can select an Excel file type in the ‘Files of type’

field (see Figure 2.32).Figure 2.32This will filter the files to show only the Excel files, then you

can select the one you want. In our example it is ‘Ch 2 hr profile spreadsheet.xlsx’ (see Figure

2.33). Note that SPSS recognizes files of many different types. And then click ‘open’.Figure

2.33This will bring up another window. Here, you will need to select ‘Read variable names from

first row of data’ (Figure 2.34). This will populate the variable view (see Figure 2.35).Figure

2.34Figure 2.35As you can see, SPSS has populated the information into the data view (see

Figure 2.35).And also populated details on the variable view (see Figure 2.36).Figure 2.36At

this stage you will need to do the following in the variable view: 1) complete and tidy up the

variable labels; 2) recode the text content of values for ‘Department’ and ‘Gender’.At this stage,

we may want to edit the data for department and gender so that they are represented as

numbers rather than strings. This is because, as mentioned earlier, we are able to perform

more arithmetic and processes on numbers than we can on text or string values. To start, let’s

update the gender data as follows: 0 = F (female); 1 = M (male).To do this we can use a simple

search and replace. We select the gender column, then go to the Edit menu and select Edit ->

Replace (see Figure 2.37). Then we replace ‘F’ with ‘0’ when prompted on the following window

and click ‘Replace All’ (see Figure 2.38).Figure 2.37Figure 2.38You will then get a confirmation

that this is complete (see Figure 2.39).Figure 2.39We then do exactly the same to replace ‘M’

with ‘1’ and then our data view ends up looking like this (see Figure 2.40).Figure 2.40Now we

need to set up gender as a ‘Numeric’ data type (see Figure 2.41).
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